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Selected Excel Basics

Throughout this module it is assumed that course participants have some familiarity
with Excel.  Because of the diversity of users and potential uses of a general
spreadsheet application there are typically some whose knowledge of spreadsheets is
well developed in certain areas but may require enhancing in others. More experienced
users will have mastered techniques to improve their efficiency while less experienced
users are continuing to build skills that will make them power users of Excel.  In this
brief introduction a few skill building techniques are discussed.

Using the Fill Handle

With a cell or range of cells is selected, the lower right-corner of the selected cell(s)
outline shows a small square with as cross known as the fill handle, indicated in the
following diagram.  When the mouse pointer is placed directly over the lower right-
corner of the selected cell(s) it forms the shape of a black cross-hair.

  Fill handle  

+

Use the handle to drag a fill series across adjacent cells.  The following types of series
may be created using the fill handle:

• to copy the same entry into other cells, type the information into the cell once, select
the cell, and then drag the fill handle with the mouse to fill adjacent cells with the
same data.

• to enter the month (Jan, Feb, Mar,...) or day of the week (Mon, Tue., ...) type the
first entry, and then drag the fill handle to fill adjacent cells with the complete
series.  Excel's AutoFill feature completes the series in the correct order.

Type the following data in row 2 of a blank worksheet and observe the outcome.

+
Fill handle

When the pointer changes 
to a black cross-hair, click 
and drag down to row 14
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• to use a number series, type the first two entries in the order you wish the series to
increase or decrease.  Different examples of series are provided in the diagram on
the left.  The fill handle is visible at the lower-right corner of the selected cells
(bottom-right of cell D2). Place the mouse over the fill handle (the pointer looks
like a small crosshair), click the left mouse button and hold while you drag to
complete the series, the diagram on the right contains the completed series.

The Fill Command

Another method of creating a fill series is to use the Fill command.  If you want to use
the same data in neighbouring cells (if, for example, you are copying a category
heading), select the cell containing the entry, and then drag over the cells you want to
fill.  Excel fills the cells with a copy of the original data.

Complete the following series of tasks:

1. Type the word Melbourne in cell A2 of the worksheet.

2. Select cell range A2:E11

3.
From the Edit  menu
   choose Fill and
             select Down
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4.
From the Edit  menu
   choose Fill and
             select Right

The selected area is filled with the text "Melbourne".

Entering a Data Series

Specific start and stop values may be entered for a data series using the Series dialogue
box.  The following steps demonstrate how to use the Series dialogue box to create a
data series in column A, the start value is 10 (entered in cell A1), the stop value is 90
and the step value is 5.

Step 1 Select the first cell of the series (Cell A1) and enter the starting value (10)

Step 2 Select the range of cells to fill (not required for the present example)

Step 3 From the  drop-down menu,

choose Fill  and from the cascade menu select 

Step 4 Complete the   dialogue box as follows and click .
This will produce the completed series shown in the right of the diagram.
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Combining the Fill Handle with the Fill Command

A useful application of the Fill Command  is in conjunction with the Fill handle.  Suppose
that the contents of a particular cell had to be replicated a large number of times across
consecutive rows.  If the cell contents in the adjacent column, either to the left or the right,
contain data of any description, then double-clicking the fill handle will replicate the cell's
contents automatically, in line with the adjacent column.  The following example, which
requires replication of the contents of cell B1 1200 times, illustrates this feature.

Place the number 1 in cell A1 and select cell A1.

From the  drop-down menu, choose:

Complete the Series dialogue box as follows:

Check the Columns 
radio button

Step value is 1
Stop value 
of 1200

Click to fill 
column A with 
1200 numbers, 
from 1 to 1200

Now enter the following formula in cell B1:   =2*A1
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Select cell B1 and double click
the fill handle to enter 1200
formulae in column B.

+   Double-click
the Fill handle  

The Cut, Copy and Paste Icons

The toolbar icons for copy, cut and paste are:
cut copy paste

Keyboard shortcuts are:
cut
 

Ctrl+X

copy
 

Ctrl+C

paste
 

Ctrl+V

The Drag-and-Drop Technique

To move or copy a selected range, the drag-and-drop  method may be used.  This is
achieved by selecting the cell range to move or copy, placing the mouse pointer in the
correct position and then dragging to the new location.  For example, suppose the cell
range A2 : B5 are to be moved to a new location two columns to the right in the same
row location, we would proceed as follows:

Step 1 Select the cell range to copy or move.

Step 2 Move the mouse pointer over the selection's border.  The mouse pointer
should change to an arrow, as follows:

Step 3 To copy the range, hold down the Ctrl  key.
To move the range nothing is required at this step.

Step 4 Drag the border.  As you drag, an outline of the selected data is visible.
When the selected cell range is at the required location, release the mouse
button to complete the task.
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Copying Data from Non-Contiguous Columns

To copy the information contained in columns A, C and E, in the following diagram,
and move it to a new position in the spreadsheet, the steps are:

Step 1 Select the cell range A1 : A5

Step 2 Press and hold the Ctrl  key

Step 3 While holding the Ctrl  key down, select the cell range C1 : C5 and then
the cell range E1 : E5

Step 4 Place the mouse pointer in the first cell of the target cell range, B7, and
Paste the contents of the clipboard.  This procedure arranges the data in
contiguous columns.

Copy and Paste Special

Frequently we wish to copy data from one worksheet location to another and paste the
values in the new location.  This requires the use of Paste Special when the data to be
copied is the result of formulae.

To copy the values stored in cells A4 : A5 in this worksheet use Paste Special.

Step 1 Select cells A4 : A5 and copy the contents to the clipboard.

Step 2 Select the first cell of the destination location, cell B4.

Step 3 From the  pull-down menu choose 

Step 4 Complete the   dialogue box by checking the

 radio button and click  to complete the task.
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Turning a Row into a Column

The layout of a worksheet facilitates the way in which information is communicated
and may also enhance our productivity.

Press  Shift  F11   to insert a new worksheet.

Enter the following data in cell range A2:G2

Type the first two entries and then use the fill handle to drag to the right.

Step 1: Select cell range A2:G2 and choose Copy

Step 2:

Select cell A5 and right-click
 
From the pop up menu
choose  Paste Special

(or from the Edit menu, choose Paste Special)

Step 3:

Check this box

Click this button
  then 

The transpose function converts rows to columns or columns to rows.  It may be
applied to a single row (or column) or a group of rows (or columns).

Exercise Place Syd-0, Syd-1, ... , Syd-6  in cells B3:G3
Transfer the contents of A2:G3 to two columns starting at cell D5.
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Faster Data Entry

Press  Shift  F11   to insert a new worksheet.

In separate cells enter the following:     (c)      (r)      (tm)

In a blank cell enter (all in lower case):   monday

Excel's AutoCorrect feature automatically adjusts the cells' contents to a predefined
value.  This is a useful feature to improve the accuracy of data entry and the efficiency
with which information is entered.

Suppose that we wished to enter the following text several times in our worksheet:

Engelbert Humperdinck

Alakazam Holofoil

Ludwig van Beethoven

For each entry we will assign a unique identifier (or abbreviation) as follows:

Abbreviation      used for this text
Engh Engelbert Humperdinck
Alak Alakazam Holofoil
LVB Ludwig van Beethoven

From the Tools  menu select AutoCorrect
and complete the following tasks:

Repeat the process for each 
abbreviation and text string
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Select any blank cell and type one of the abbreviations:  Engh, Alak or LVB

Excel replaces the abbreviated text with the text string previously stored using the
AutoCorrect feature.

Removing an Entry from AutoCorrect

To remove an entry from AutoCorrect, simple select the entry and click on the Delete
button.

Select the entry

Click this button

Using AutoComplete

If you need to enter a lot of repetitive data, such as entering the same text labels
repeatedly, then Excel's AutoComplete feature provides a more efficient way of
entering such data.

To illustrate, suppose we wanted to use Victoria and Melbourne repeatedly in our data
entry.

Step 1: Select any blank column:  


in row 1 enter    Victoria
 
in row 2 enter    Melbourne

Step 2: Move down to the cell in row 3 of the column and right-click

Step 3: Choose  Pick from the pop up menu.
A list of previously typed words appear.

Step 4: Choose the word you want from your list and Excel will automatically
insert it in the cell.

Adding Comments to Cells
You can add comment notes to any cell in your worksheet to help you identify data or
explain the contents.  Comments will not affect the worksheet in any way and do not
appear in the printed document.

Comments become visible when the pointer passes over a cell containing a comment - a
comment box pops up.  Cells containing comments may be identified by small red
triangles in the upper-right corner of the cell.

To add a comment to a cell:
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Step 1 Select the cell you wish to add the comment to

Step 2 Right-click your mouse
 
 
Step 3 From the pop-up menu 

choose Insert Comment

Step 4 In the box that appears type the comment.

To Edit , Delete or Show  a comment, 
select the cell containing the 
comment and right-click your mouse.
Select the appropriate sub menu:

Using the Shift key to Select a Range

Open a new worksheet and place 1200 values in column A.

Place 1 in cell A1  and then use Edit  ➥  Fill ➥  Series to place 1200 values in
column A  (see previous section headed Fill Handle).

Enter the formula in cell B1:   =2*A1

Now use the Fill handle to replicate this formula 1200 times.

Split the worksheet window
so that both the top and bottom
of the data are visible.
 
Select cell B1
Hold the Shift  key down
and select cell B1200.
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Copy the selected cell range.

Select cell D2.

From the Edit  drop-down menu (or right-click), choose .

Check the Values  radio button 
and click the  button.

Enter the formula in cell C1:  =A1+B1-D1

Select cell C1 and choose Copy from the Edit menu.

With C1 selected, hold the Shift  key down and select cell C1200.

Choose Paste from the Edit menu.

Custom Formatting

Excel has a selection of standard numerical formats, which are accessed by choosing
Format from the drop-down menu, then choose Cells and click on the Number tab.

Open a new worksheet and place any numeric values in cell range A2:A6.

Select cell range  A2:A6

Activate the format
cells dialogue box.
 
Click the Number tab.
Select Custom  from
the Category list.
 
In the Type: text box
enter:  "$AUS  "0.00
 
Click the   button.

The information embedded in the double quotation marks precedes the data formatted
to two decimal places.  The double quotes may be placed before or after the required
number format to achieve the desired result.

="The net profit is:   "& TEXT(H10,"$#,##0.00") Cell H10 contains a numeric value
="Total:   "&DOLLAR(1287.367,2)
="Total:   "&DOLLAR(H10,2)
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Naming Cell Ranges

Open a new worksheet and place 120 values in column A starting from A2.

Enter the labels: in cell A1 Series1
in cell B1 Series2
in cell D1 Series1+2

Enter the formula: in cell B2 =1.5*A1

Use the Fill handle to replicate the formula so that it fills the cell range B3:B121

Select cell range  A2:A121
 
Click in the Name Box
Enter the range name: Series1
and press the Enter  key.

 Name Box 

Series1

Repeat the process for the data in column B.

• select cell range  B2:B121,

• click in the Name Box,

• enter the range name Series2 and

• press the Enter key.

Standard spreadsheet operations may now be performed on these cell ranges using the
range names assigned to them.  Complete the following tasks in the nominated cells:

Cell Formula
D2 =AVERAGE(Series1)
D3 =SUM(Series1)
D4 =SUM(Series1,Series2)
D5 =SUMXMY2(Series2,Series1)

Splitting the Worksheet Window

Many spreadsheet tasks take up an area of the worksheet far greater than is visible on
the average computer screen.  The ability to split the worksheet window increases the
flexibility of the work environment.  Two methods of arranging the worksheet window
are presented here.
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Method 1

Step 1 From the  drop-down menu select Split
This will split the worksheet into 4 sections as follows:

Note that within each section it is possible to scroll through the
worksheet independently of any other section, each window has it's
own vertical and horizontal scroll bars.

Step 2 Removing the left (or right) section:
Place the mouse pointer on the bar dividing the worksheet vertically,
click the left mouse button and drag to the left (or right) of the
worksheet until it disappears.

A similar approach may be used to remove the top (or bottom)
panels.

Step 3 Drag the horizontal bar to the desired position, it is generally a good
idea to split the worksheet so that the top portion represents about
two-thirds and the bottom about one-third.

Step 4 Arrange the information in the worksheet so that both the beginning
and ending sections of the data set are visible.

Method 2

Split worksheet horizontally

Click left mouse button, hold and
drag downwards to desired position.

Place mouse pointer here

Split worksheet vertically

Click left mouse button, hold and
drag to the left to desired position.

Place mouse pointer here

© John Flaherty



-  15  -

A Quick Look at Charts

Open a new worksheet and place 120 values in column A starting from A2.

Enter the labels: in cell B1 Series1
in cell C1 Series2
in cell D1 Series2

Enter the formulae: in cell B2 =INT(RAND()*100)+600
in cell C2 =INT(RAND()*100)+750
in cell D2 =INT(RAND()*100)+900

Split the worksheet horizontally so that the beginning and end of the data are visible.

Select cell range:  B2:D2  and double-click the Fill handle to duplicate each of these
formulae 120 times in columns B, C and D.

Select cell range  B2:D121  and choose Copy from the Edit  menu.

Select cell B2 and choose  from the Edit menu.

Check the  radio button and click the  button.)

All data in columns B, C and D are now values.

Sort the data: Select cell range B2:B121 and click on the
sort descending button on the tool bar:  

Repeat the sort for data in columns C and D.

Select cell range:  B1:C121 and click on the Chart Wizard button .

Select the
following
 Chart type
 and 
    sub-type:
 
 
Click the

button.
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In Step 2 of the Chart Wizard click on the  tab and ensure the column B
values are in the  text box.  The values in column C represent the Y-axis
values.

Click the  button to complete the chart and place it in the active worksheet.

The data in column D has to added to the chart.

Click on the chart, near the outer edge, to select it.

From the Chart
drop-down menu
select Add Data.
 
Enter D2:D121 in
the Add Data
dialogue box.
Click  

The magnitude of the scale of Series3 is somewhat larger than for Series 2, it requires
its own axis.  To add a second axis to the chart, double click the line representing
Series3 on the Chart to access the Format Series dialogue box.

Click on the Axis tab and
check the Secondary axis
radio button.
 
Click the  button.

Some additional formatting may be required to complete the chart.  Double clicking on
the various parts of the chart will provide access to the various dialogue boxes to enable
editing.  Charts should be correctly labelled; a chart title, and a label for each of the Y-
and X-axis.  Legend should be included if necessary, this is typically the case if more
than one series is included on the chart.  If both a Primary and Secondary axis are
used it should be made clear which axis is associated with a particular data series.
Beyond this the chart should be as simple and uncluttered as possible.
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Make a Duplicate Copy of a Worksheet

Click on the worksheet tab to select it.
 
Then right-click your mouse.

 

Worksheet tabs

To make a copy of a worksheet:

Step 1 Point to its tab at the bottom of the worksheet and right-click your mouse.

Step 2
From the pop up menu
select Move or Copy

Step 3 Select (move to end)
 
    and click on the
 
Create a copy checkbox.

To place the new worksheet 
after all worksheets in the 
workbook select:

Check this box

Click this button

Naming the New Worksheet Double-click the tab of the new worksheet and
type the name you wish to give the sheet.
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Using a Graphic for a Background

In Excel you are not limited to the plain old white or somewhat shaded background for
your worksheets. Instead, you can use a graphic image for a background. The effect is
much like the backgrounds you see on Web pages--the image used as the background
is tiled (repeated) so that it fills the entire background of the worksheet.

If you have a favourite graphic that you would like to look at, you can tile one or more
of your worksheets with it.

To use a graphic as a worksheet background, follow these steps:

Press  Shift  F11   to insert a new worksheet.

To find a sample graphic, visit: http://www.allposters.com/

Find a graphic and save it to your disk.

Step 1

From the Format menu
   select Sheet
 
From the cascade menu
   select Background

Step 2 Use the controls in the dialog box to locate and select the graphic image
you want to use as a background.

Step 3 Click Insert to include the background.

The image is imported and fills the background of your worksheet.

To remove a background:

   1. Choose Sheet from the Format menu.

   2. Choose Background from the submenu.

   3. Choose Delete Background.

The dialog box is closed and the background is removed.
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Installing the Analysis ToolPak

When Excel is initially installed on a computer some of its features are not accessible.
A feature that is frequently used, and requires installation, is the Analysis ToolPak
Add-In.  This Add-In provides access to additional spreadsheet functions and a
collection of statistical procedures.

From the Tools  drop down menu select:

Click in the check box to the left of Analysis ToolPak:

Check the box

To complete the installation click the  button.

The REPT Function

To repeat a text string, or number, a given number of times use the REPT function.
The syntax for the function is as follows:

=REPT("text string", Number of repetitions)

Try the following: =REPT("*",120)

=REPT("John Howard  ",100)

=REPT(100,100)
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The Convert Function

If you are dealing with measurements that must be converted from one measuring
system to another, it can be a real bother to look up the formulas and enter them into
Excel. For instance, if you had to convert Watts to horsepower, where would you start?

Fortunately, Excel includes a function that will handle many different unit conversions
for you. The CONVERT function is part of the Analysis ToolPak , and will handle
dozens of conversions. The syntax for the function is as follows:

=CONVERT(number, "from_unit", "to_unit")

You simply supply the value you want to convert, along with an abbreviation for the
units you are converting from and to. For instance if you wanted to find out the
equivalent of 300 BTUs when you convert to calories and temperature from Celsius to
Fahrenheit, you would use the following:

=CONVERT(300, "BTU", "c") BTUs to calories
=CONVERT(35,"C","F") Celsius to Fahrenheit
=CONVERT(95,"F","C") Fahrenheit to Celsius

You can perform conversions in the areas of weight, volume, distance, time, pressure,
energy, force, power, magnetism, and a few others. A complete list can be found in the
Excel on-line Help system. (Simply search for "CONVERT worksheet function.")

From the Help menu
choose Contents and Index.
 
 
Then click on Index

Enter search 
string here

Click on

To get help and 
examples click 

this button
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Excel's On-Line Help

Excel provides on-line help for functions and procedures within the application, it also
provides Lotus 1-2-3 Help and for users of Office 97 or later there is help available to
prepare Web based documents.

From the  pull-down menu select Contents and Index .

When the Contents  tab is active a list of topics is presented.

A category you may wish to explore for Financial models is Financial Functions.

Select Financial Functions to obtain a list of Excel's financial functions.  Select the
function you are interested in and click for a description of the function and an example
of how it is used.

Using the Index Tab

To get help for a specific function or procedure click the Index  tab after you have

selected Contents and Index  from the  pull-down.  Enter your query in the
box provided.  Suppose you are interested in "Annuities", type this word in the box and
click on Display.

Using Office Assistant

To activate Office Assistant
press the F1  key or

select Microsoft Excel help  from the  pull-down menu

Office Assistant provides context sensitive help, simply type your question in the
nominated box and click the search button.

Don't expect success every time.
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Keyboard Shortcuts

Key Action

F1 Help

F2 Edit A Cell

F3 Displays the paste name box

F4 Changes cell reference from relative to Absolute. Click in the
cell then press the F4 key repeatedly to rotate from relative to
Absolute references

F5 Go To a cell or range name

F6 Next Pane

F7 Spell Check

F8 Activate range extension feature

F9 Recalculate Spreadsheet

F10 Active the Menu Bar

F11 Insert New Chart

F12 Save As

Ctrl   C Copy Selection

Ctrl   X Cut Selection

Ctrl   V Paste Selection

Ctrl   F Find Text

Ctrl   H Replace Text

Ctrl   O Open a File

Ctrl   N Create a New File (New Workbook)

Ctrl   P Print File

Ctrl   S Save File

Ctrl   Z Undo Last Action

Ctrl   Y Redo Last Undo

Ctrl   F3 Display Create a Name Box

Ctrl   F9 Minimize Active Worksheet

Ctrl   F10 Restore Active Worksheet

Shift   F2 Edit/Create Cell Note

Shift   F4 Repeat Find

Shift   F10 Activate the Cell Popup Menu

Shift   F11 Insert New Worksheet

CTRL ; Enters the current date

CTRL : Enters the current time
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